SAMPLE PREPARATION

- Check that the surface is free of defects (cracks, crevices, etc.);
- Check that the sample was not attacked with drills or fungi;
- The sample must be large enough to cover the light beam of the device (surface of approximately 1.5 x 1.5 cm);
- Perform the measurements only with heartwood samples;
- The analyzed surface or face should be longitudinal (tangential or radial);
- Sand it with No. 80 sandpaper, always in the direction of the fiber;
- Remove with a brush all the sawdust from the sanding process.

OBTAINING SPECTRA

1. TURNING ON THE EQUIPMENT
   a. Press the On/Off button.
   b. Press the trigger to start the equipment.

2. INTERNAL CALIBRATION OF THE EQUIPMENT
   a. Using the arrow keys, scroll to “Self Test” and press “Select”.

Rapid-Field Identification of *Dalbergia* Woods and Rosewood Oil by NIRS Technology
b. Select the “Start Scan” option, wait for the equipment lamp to warm up and the self-test to be performed.

c. The message of “Pass” should be displayed at the end of the test. If the message is “Fail”, check the battery level of the equipment or contact maintenance service.

d. Select the option “Return to Main Screen”.

3. **SELECTION OF METHOD AND BATCH FOR SPECTRA ACQUISITION**

   a. In the main menu, select the option “Tools” and then “Acquire Signatures”.

   b. Click on the “Method” option and select a method already saved in the device or create a new one in “New”.

   c. Repeat the procedure for batch selection through the “Batch” option.

   d. To start the spectra acquisition, select the option “Continue to Start Run”.
4. **Spectra Acquisition**

a. Position the sample in a way that it completely covers the output of the radiation beam (do not cover the sample with your hand) and press “Select” or pull the trigger of the equipment. A warning that the lamp is being turned on will appear.

b. There will be a message that the background is being acquired and the spectrum of the first replicate will be acquired. If the spectrum is as expected, select “Select” to move on to the next one. If not, select “Esc” and repeat the reading.

c. Slightly change the position of the sample and press “Select” or press the trigger of the equipment to acquire the spectra of the next replicate. Again, if the spectrum presents any unwanted variation, select “Esc” and repeat the reading.

d. At the end of the spectra acquisition for all the replicates, the equipment will return to the acquisition menu. The name in the “Sample” section is automatically updated.

e. When finished with all samples, select the “Esc” option to return to the main menu.
5. **TRANSFERRING THE SPECTRA TO THE COMPUTER**

a. In the main menu, select the option “Sync (Send Data Across USB)”.  

![Screen showing sync status](image)

b. A message will appear with the number of files to be transferred and a confirmation that the device is ready for transfer.  

![Screen showing confirm readiness](image)

c. Only now connect the transfer cable to the device and the USB to the computer that has the device’s Administrator program installed.  

![Connecting the transfer cable](image)

d. The computer should recognize the device and the transfer will be automatic.  

![Computer recognizing device](image)

The folder with the new files is named with the transfer date and will be in the path:  
*This Computer > Local Disk (C:) > Thermo > Data > ARCHIVE*

e. A message will appear stating that the transfer was successful and that it is safe to remove the cable from the computer and equipment.  

![Message indicating transfer success](image)
6. **TURNING OFF THE EQUIPMENT**
   a. In the main menu, select the option “Logout” and confirm by selecting “Yes”.
   b. Press the On/Off button until the message of “Powering Down” appears. Wait until the screen goes out and the equipment is properly turned off.

7. **CREATING THE MODEL**
   a. Open the program “Method Generator”.
   b. Click on “Model” and enable the advanced version of the program.
c. Click on “Read Data File” and select the file containing the spectra of the samples selected for the model training stage.

d. Click on “Yes” to confirm that the file containing the MicroPHAZIR™ NIR spectra contains absorbance data.

e. In some cases, there will be a message stating that time data is missing. That is not a problem, just click on “OK”.

f. Make sure that only the data you are going to use has been loaded. If there are any samples that will not be used, select them and click on “Remove Sel”.

g. Select all samples of the class you wish to base the model on (click on the first sample and, keeping it selected, drag the mouse pointer till the last one you want). Click on “Edit Y-Value”, enter 1 and select “OK”.
h. Click on “Select All” and all spectra will be plotted on the graph on the side.

i. For the pre-processing section, select the method of analysis (Classify or PLS1) and modify each step as needed. In this example, the chosen method of analysis is PLS1, the first pre-processing step is SNV and the second step is 1st Derivative by S. Golay. In all steps, the wavelength to be analyzed must be specified. In this example, the wavelength range chosen was from 1595 to 2285 nm. For the Savitzky–Golay parameters, values of 1 for “Derivative”, 9 for “Smooth Pts” and 2 for “Degree” were chosen. These parameters specify the order of the derivative, the number of points in the smoothing window, and the degree of the polynomial used for smoothing. To process the data, click on “Pre-Process”.
j. The pre-processed spectra will be displayed on the graph.

k. Select the type of cross validation to be used:

- Full (recommended for sets of up to 30 samples and without replicates)
- By Method/Group
- 111222333 (used when having replicates in sequence and cross-validating with sample blocks)
- 123123123 (used for cross-validation with sample blocks without replicates)

And then click on "Perform PLS1".

l. Modify the plotted graph to the “RMSE vs Factors” type and select the smallest number of factors (latent variables) for which the RMSE values start to stabilize. In the example below, the chosen number of factors would be 5. Click on “Create PLS Application”.

m. The dialog box for the model parameters will appear. If necessary, change the number of latent variables (“Number of PCs or factors”) to the one chosen in the model and the limits (“Range limits”) to be between -2 and 3, with an “Outlier” message when outside this range. Click on “OK”.


The PLS1 model will perform the data discrimination in two classes. One of them will have a class value of 1 (one) and the other will have a class value of 0 (zero). Therefore, when analyzing unknown samples, the method should find predicted class values close to 1 for class 1 and close to 0 for class 0. In this sense, note that the limits -2 and 3 for outlier are extremely permissive. Depending on the model’s fit these values can be reduced at the researcher’s discretion (e.g., -1.5 and 2.5) to increase the sensitivity of outlier detection.

n. Name your model and click on “OK”.

o. Your model has been created and is saved in the location displayed in the system dialog.

p. In order to use this model in the equipment for the analysis of new samples, it must be transferred to the spectrometer. To do this, connect the spectrometer via USB cable to the computer where the model was created and saved and follow the instructions that will appear on the screen.

q. When the transfer is concluded, select the option “Run” and the desired method/model (as described in item 3a of the manual), which will be in the “Libraries/Methods” section.

r. Once the method has been selected, the spectrometer is ready for the analysis of new samples. The estimated class value is shown on the equipment screen. In order to conclude if the analyzed sample belongs to the discriminated class (CLASS 1) or to another class, the class value must be compared with the discrimination threshold, to be determined in the next section.
8. **Determination of the Limit of Discrimination and Model Validation**

   a. Click on “Read Data File” and select again the file that contains the spectra of the samples that were selected for the model training step.

   b. Click on “Yes” to confirm that the file containing the MicroPHAZIR™ NIR spectra contains absorbance data. Click on “OK” if the message that time data is missing is displayed.

   c. One more time, make sure that only the data you are going to use has been loaded and remove any samples that will not be used by selecting them and clicking on “Remove Sel”.

   d. Select all samples of the same class used to create the model and change their Y-value to 1 (click on “Edit Y-Value”, type 1 and select “OK”).

   e. Click on “Select All”. In the “Model” tab, click on “Model Validation” and select the model file to be used.

   f. A new tab with the validation report will pop up. On the “File” tab, click on “Save Details”, name the file and save.
The saved file contains the estimated class value result (in this case its wood species) for each spectrum. If this file contained validation samples, the results could be analyzed to check the method’s success rate. For this example, this data contains the training samples that will be used to determine the discrimination threshold of the method in the following steps.

g. Open the previously available Excel file named “Training and Validation” and also the one referring to the model validation from the previous topic.

h. Select columns A, B, C and D of the file saved in item “f”, referring to model validation, and paste it in the same columns of the “Training” tab of the “Training and Validation” worksheet.

i. In column A (“Measurement”), change the data value to start at 1 and complete the data in that column in numerical order.

j. In column E (“class 1”), paste the data from column D (“Predicted Value”) only for samples that have a class value equal to 1, that is, those that contain a value of 1 in column C (“Actual Value”).

k. In column F (“class 0”), paste the data from column D (“Predicted Value”) of the other samples, which must contain a value of 0 in column C (“Actual Value”).

l. The value of the discrimination threshold will be calculated automatically and will be displayed in cell K1. The formulas for calculating the discrimination threshold are in the cells behind the graph of the estimated class value versus the sample number. The details of these calculations are described in the article Soares et. al. Quim. Nova, 40, 418-426, 2017. doi: https://doi.org/10.21577/0100-4042.20170014.

9. ANALYSIS OF A SET OF UNKNOWN SAMPLES

a. In the same way as in the previous topic, click on “Read Data File” and select the file containing the spectra of the samples to be analyzed.

b. Click on “Yes” to confirm that the file containing the MicroPHAZIR™ NIR spectra contains absorbance data. Click on “OK” if the message that time data is missing is displayed.

c. Again, make sure that only the data you are going to use has been loaded and remove any
samples that will not be used by selecting them and clicking on “Remove Sel”.

d. Click on “Select All”. In the “Model” tab, click on “Model Validation” and select the model file to be used.

e. On the “File” tab of the validation report window, click on “Save Details”, name the file and save it.

f. Select columns A, B and D of the file saved in the previous item. Paste them in the same columns of the “Validation” tab of the “Training and Validation” worksheet.

g. In column A (“Measurement”), modify the data value to start at 1 and run the entire column in order to follow the numerical order.

h. Column D (“class pred”) will determine whether or not the sample belongs to the species specified in the model. The result can also be seen in the graph. Samples above the discrimination threshold (red line) are considered as belonging to the species for which the model was trained to discriminate (being identified as BELONGING TO CLASS 1). The samples below the red line are considered as not belonging (OTHER CLASSES).
1. **ASSEMBLY OF THE INSTRUMENT**

1.a. A special accessory connected to the MicroPHAZIR handheld device is necessary to acquire a near-infrared spectrum of a liquid sample, as illustrated in figure 1.

1.b. The accessory supports the vial that will contain the essential oil (EO) sample. It is also manufactured and marketed by ThermoFisher Scientific™.

1.c. The accessory will be correctly seated in the MicroPHAZIR when the right and left looks double click.

1.d. Place the instrument in a stable horizontal position for reading the liquid sample, and use support if needed. Then carefully insert the vial with the sample into the compartment.

2. **PREPARATION OF EQUIPMENT FOR SAMPLE ANALYSIS**

The analysis is done directly with the oil obtained, without the need for any previous sample preparation. It is necessary to use only an aliquot of ~1 mL of EO for triplicate analysis. To read the sample, initially turn on the equipment, and follow the same procedures described in items 1 to 3 in the SOP for Wood Analysis. Briefly presented below:

2.a. Turn on the Equipment
   - Press the On/Off button.
   - Press the trigger to start the equipment.

2.b. Internal Calibration of the Equipment
   - Go to "Self Test" and press "Select".
   - Select the "Start Scan" option and wait for the device lamp to warm up and perform the test.
   - The "Pass" message should be displayed. If the message is "Fail," check the device’s battery level.
   - Select the option "Return to Main Screen".
2.c. Selection of the Method and Batch
- From the start menu, select the “Tools” option and then the “Acquire Signatures” option.
- Click on the “Method” option and select a method already saved in the equipment or create a new one in “New”.
- Do the same to select a batch using the “Batch” option.
- To start the spectra acquisition, select the option “Continue to Start Run”.

2.d. Care in Sample Preparation
- Carefully add an aliquot of the essential oil to the vial with a micropipette, touching the tip to the vial walls and slowly draining the oil.
- Check the presence of air bubbles in the sample to be analyzed and eliminate them by gently tapping the walls of the flask.

- Clean the outside of the vial with a paper towel.
- Position the vial in the accessory compartment as illustrated in Figure 6.

3. AQUISIÇÃO DOS ESPECTROS
- After carefully inserting the vial containing the oil into the accessory, press “Select” or pull the trigger of the equipment.
- The device automatically starts the procedure to obtain the “background” spectrum. Then the spectrum of the first replicate will be acquired.
- Figure 7 shows a rosewood oil spectrum. Check if it is similar to the acquired one. Then, press “Select” to move on to the subsequent measurement. Otherwise, select “Esc” and repeat reading.
4. TURNING OFF THE EQUIPMENT

- In the Main Menu, select the option “Logout” and confirm by selecting “Yes.”

- Press the “On/Off” button until the “Powering Down” message appears, and wait until the screen goes out.

5. TRANSFERRING THE SPECTRA TO A COMPUTER AND CREATING A CLASSIFICATION MODEL

- Follow the same procedures described in the SOP for Wood Analysis, replacing only the PLS1 model with “Classify”.

- After acquiring the spectrum from the second replicate, visually assess agreement with the first spectrum. In case of a significant variation, discard the most discordant spectrum and perform a new measurement. Otherwise, follow up with a new replica.

- The displays on the side and bottom of the instrument show the number of each replica.

- When completing the acquisition of the three spectra of a sample, the instrument returns to the Acquisition Menu, waiting for a new sample. In “Sample,” the numbering is already updated.

- When finishing the acquisition of the spectra of all samples, select the “Esc” option to return to the main menu, as shown in Figure 9.